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Pro/ENGINEER (Creo 3.0) Basics 105

Course Description:

Pro/ENGINEER (Creo) Basics

3 credit hours

Exploration of the theory and application of solid modeling techniques for product
design and manufacturing. Prerequisite: Intro to Engineering Drawings 101 or consent of
instructor.

Course Objectives:

Provide the student with the knowledge and practical experience in the areas of 3D CAD
modeling of parts, assemblies, and the creation of mechanical drawings from the
models.

Textbook
Creo Basics free/pdf., parts, and videos provided on www.vertanuxl.com ?
Evaluation Scale: vertanux
A 90% to 100%
B 80% to 89%
C 70% to 79%
D 60% to 69%
F Below 60%
Points:
Exercises 300 pts
Mid Term 300 pts
Final 300 pts
Labs 100 pts
Total 1000 pts


http://www.youtube.com/user/vertanux1

General Course Outline

Date

Week

Topic

10.

11.

12.

13.

14.

15.

16.

Introduction to the Interface Lecture
Modeling Theory - Sketching and Base Feature Geometry Creation. Lab

Revolved Features and Mirroring

Part Modeling
Secondary Features. Fillets, Chamfers, Draft, Patterns, Mirroring.

Sweeps, and Circular Patterns

Modeling Quiz and CAD Administration
Building Assemblies (Bottom-Up method “BU”)
Creating Drawings. Review for Mid Term

Mid Term Exam

3D Curves and Sweeps

Swept Blends/Lofting

Assemblies Creation (Top-Down Method “TD”)
Assembly/Part Editing (“TD” & “BU” Methods)
Sheet Metal Intro

Assembly Project (continued)

Lab time to complete exercise, Review for Final Exam

Final Exam

Required Hardware
16+ Gigabyte USB Flash / Thumb Drive

Required Software (Click on link below)
CREO 3.0 Educational Edition



http://www.ptc.com/appserver/mkt/educational/program.jsp?&im_dbkey=86793&icg_dbkey=851

STUDENTS WITH DISABILITIES

We welcome students with disabilities and are committed to supporting them as they
attend college. If a student has a disability (visual, aural, speech, emotional/psychiatric,
orthopedic, health, or learning), s/he may be entitled to some accommodation, service,
or support. While the College will not compromise or waive essential skill requirements
in any course or degree, students with disabilities may be supported with
accommodations to help meet these requirements.

The laws in effect at college level state that a person does not have to reveal a disability,
but if support is needed, documentation of the disability must be provided. If none is
provided, the college does not have to make any exceptions to standard procedures.

All students are expected to comply with the Student Code of Conduct and all other
college procedures as stated in the current College Catalog.

PROCEDURE FOR REQUESTING ACCOMMODATIONS:

1. Go to SRC108 and sign release to have documentation sent to the college, or bring in
documentation.

2. Attend an appointment that will be arranged for you with the ADA coordinator or
designee.

CLASSROOM PROCEDURES:

1. Attendance of each scheduled class meeting is required unless otherwise specified by
the instructor.

2. Daily work problems and hand-outs will be maintained in a notebook and turned in
upon the instructor’s request.

3. Reading assignments will be made prior to discussing the material.

4. Keep your drafting workstation clean and free of miscellaneous materials.

5. Please report any malfunctioning equipment to the instructor.

LABORATORY UTILIZATION:

1. Regular daytime hours. The room is open for your use starting at 8:00AM daily. Even
though classes are being held, you are encouraged to find an open area and

work in the laboratory.

2. There are evening classes, but you may use the lab up to 10:00PM.

3. On weekends, the lab will be available on Saturdays from 9:00AM to 4:00PM. The

lab will be closed on Sundays.

INSTRUCTOR’S RESPONSIBILITY:

1. Present material in @ manner that can be understood by each student.

2. Respect each student as an individual, to be of assistance in any way possible, and to
help solve problems, but not to solve problems for the student.




3. Keep records of your progress and to summarize your learning experiences with a
final

Attendance and Cheating Policies

Introduction: Drafting is a technical profession in our society; consequently,
presentations in this course are factual and technical, and final grades represent the
student’s accomplishment of the learning activities.

Attendance: Attendance at each class meeting is required. Attendance may be a factor
when determining the final grade. Your instructor will specify his/her policy concerning
the relationship of attendance and the final grade.

Each instructor has the option of taking attendance for his/her personal use. If a
student misses class because of illness, a field trip, or any other AUTHORIZED reason,
the student is obligated to determine what was missed, and will be held responsible for
that work. If a student is absent without an excused absence, he/she will also be held
responsible, and must obtain all information from some source other than the class
instructor. Instructors DO NOT have to accept any

make-up work, do individual tutoring, or make special test arrangements for any
UNEXCUSED ABSENCE.

Cheating: Cheating in this department is interpreted to mean the copying, tracing, or
use of another person’s work for the purpose of completing an assignment.

Individual initiative and personal performance in completing all assighments is required
of all students. This course may seem to offer situations that are conducive to cheating.
However, evidence of cheating on the part of any student will be sufficient cause for an
assignment of an “F” for the course.

Instructors reserve the right to change a grade after the end of the semester if there is
evidence to warrants.

CAD 105 EXERCISES & VIDEOS INDEX

27:32
E1 CREO Parametric 2.0

Exercise 1 - Introduction to sketching, modeling and options menu inside Creo 2.0, Also, basic rendering

tools.


http://www.youtube.com/watch?v=Qug3t7k9hFw&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=1
http://www.youtube.com/watch?v=Qug3t7k9hFw&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=1

MODELINGg
BASICS - 2
-REVOLVE
-SKETCH MIgmOFR

L ___________________18:46

E2 CREO Parametric 2.0
Exercise 2 - Introduction to Sketch Mirroring, and Revolved features inside Creo 2.0...

MODELING

E3 CREO Parametric 2.0
Exercise 3 - Secondary feature modeling, Extrusions with (new) taper/draft function. offset datum planes,

extrude up to next, engraved text.

E4 CREO Parametric 2.0
Exercise 4 - Introduction to sweeps, revolved features, filleting, circular patterns.

q

assemsL R
BasICS - @5

E5 CREO Parametric 2.0 (new)
Exercise 5 - Bottom-up assembly creation

DETAILING
BASIES <1 &
VIEWS &V
-ANNOTATIONS

L 112:23
E6 CREO Parametric 2.0
Exercise 6 - Introduction to 2D Drawings, Detailing, Layout, Section, Detail, Auxiliary views, Dimensioning.

MODELIN
BASICS©
-MIRROR \\ ).,
-3D GUIDE /

E7 CREO Parametric 2.0
Exercise 7 - Creating 3D Guide Curves/Path, Sweeps, Mirroring features...


http://www.youtube.com/watch?v=DICPD-4iRNs&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=2
http://www.youtube.com/watch?v=DICPD-4iRNs&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=2
http://www.youtube.com/watch?v=m96FdiqNpOE&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=3
http://www.youtube.com/watch?v=m96FdiqNpOE&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=3
http://www.youtube.com/watch?v=j8Diz2zqzDk&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=4
http://www.youtube.com/watch?v=j8Diz2zqzDk&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=4
http://www.youtube.com/watch?v=apke1Y6YRUA&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=5
http://www.youtube.com/watch?v=apke1Y6YRUA&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=5
http://www.youtube.com/watch?v=WoG88kaYybM&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=6
http://www.youtube.com/watch?v=WoG88kaYybM&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=6
http://www.youtube.com/watch?v=gtRwh9xxgnI&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=7
http://www.youtube.com/watch?v=gtRwh9xxgnI&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=7

11.

12.

13.

T ——
MODELING

BASICS - 6

-SWEPT

AKA: "
T

E8 CREO Parametric 2.0

Exercise 8 - Swept Blends, Mirroring, using Sketch Splines to create a boat hull sections. Download the

free training manual at www.vertanuxl.com

ASSEMBLX
BASICS
-TOP-D
-EDITIN

____________________18:56|
E9 CREO Parametric 2.0
Exercise 9 - Introduction to Top-Down Assembly Modeling...

Ma== semss
ASSEM

BASIC

-ED

N 18:8
E10 CREO Parametric 2.0
Exercise 10 - Top-Down Assembly Modeling

[ ——— |
SHEET METAL

BASICS <13
-TOP-
— T

E11 CREO Parametric 2.0
Creo 2.0 Sheet Metal basics, Top-Down method

T
MIDTERM E
REVIEW

BOTTLE

L
CREO Parametric 2.0 MIDTERM REVIEW

Mid-Term Exam Review - Covers modeling parts, bottom-up assemblies, and drawing creation.

B N
FINAL EXAM >
REVIEW

CLOCK. !

[ D7:15
CREO Parametric 2.0 FINAL EXAM REVIEW
Final Exam Review



http://www.youtube.com/watch?v=mUWucy-R1wE&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=8
http://www.youtube.com/watch?v=mUWucy-R1wE&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=8
http://www.youtube.com/watch?v=6aPtjeVfELo&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=9
http://www.youtube.com/watch?v=6aPtjeVfELo&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=9
http://www.youtube.com/watch?v=2FLdJUcwxbM&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=10
http://www.youtube.com/watch?v=2FLdJUcwxbM&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=10
http://www.youtube.com/watch?v=afbZlW5KEqI&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=11
http://www.youtube.com/watch?v=afbZlW5KEqI&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=11
http://www.youtube.com/watch?v=xaOzQLh8adg&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=12
http://www.youtube.com/watch?v=xaOzQLh8adg&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=12
http://www.youtube.com/watch?v=BR4cukg6o4M&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=13
http://www.youtube.com/watch?v=BR4cukg6o4M&list=PLROUP1bV8REQ-dW6H5PCFvxyHeeVgWnlD&index=13

CAD 105 TOTALS (E - Exercise, L-Lab, Q-Quiz)
e F[1-10pts

o L1-10pts

o Llb-10pts
e [F2-30pts

o L2-5pts

o Q1-10pts
e [3-—30pts

o L3-5pts

o L3b-b5pts
e [4-30pts

o L3c-5pts
e [E5-30pts

o L5b-10pts
e [E6-30pts

o L6-10pts
e [E7-30pts

o L3d-5pts
e [8—30pts
e [F9-30pts

o L9-5pts
e [E10-30pts

o Lllc-5pts
e [F11-30pts

o L11d-5pts

MIDTERM - 300pts
FINAL — 300pts
TOTAL - 1000pts




Introduction to Pro/E - CY€O

CYe OO Parametric 3.0 Interface

Ded i R TRg PRT0001 (Active) - PTC Creo Parametric Student Edition (for educational VIeW Optlons = B =
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications & Je) e - e
g 3 User-Defined Feature 7 s AL H co Revolve & Project <y Or
e Copy Geometry X% point ~ ) eep ~ o | Style —
Regenerate Plane Sketch  Extrude Boundsry Component
- Bl 9) 3%+ Coordinate System # Swept Blend Blend [l Freestyle  Interface
Operations Datum apes v Engineering = Editing ~ Surfaces v Wodel Intent -
AL Q@ e 302 % e
Model Tree
(0 PRT0001.PRT |
7 RicHT . cons
e Ribbon Menu
£7 FRONT ~ -
3x PRT_CSYS_DEF ~ .. .
O » Origin (Axis Center x-0, y-0, z-0)
Feature Manager S par covs_ e
= T %
View port
Sa| |§@ | = Using the template defaukt SPRO_DIRECTORY \templates\inibs._part_solid.prt as the template # Smart

Mouse Buttons
Left Button - Most commonly used for selecting objects on the screen or sketching.

Right Button — Used for activating pop-up menu items, typically used when editing.
(Note: you must hold the down button for 2 seconds)

Center Button — (option) Used for model rotation, dimensioning, zoom when holding
Ctrl key, and pan when holding Shift key. It also cancels commands and line chains.

Center Scroll Wheel — (option) same as Center Button when depressed, only it activates
Zoom feature when scrolling wheel.

10



“Options & Properties” menus “The heart of CY€0”

Selecting the “File” — “Options” pull down menu (located at the top left side of the
screen) opens the active documents Options.

m Yy A - — 7
Bo-o ~
Creo Parametric Options
File=  Model Analysis  Annotate Favortes I”"| change how entties are displayed.
t - ~ Environment
o System Colors Geometry display seftings
| j New Recent Files Model Display Default geometry display: Shade With Edges v
P Entity
s Open Last Sessio Selection Edge quality display: Very High v
i Open Sketcher Tangent edges display style:  Solid =
Assembly
|:’ 5 Data Exchange Anti-Aliasing 16X v
ave
Sheetmetal [ Show colors assigned to model surface
42] SavehAs b Customize Ribbon [] show smooth ines
- Quick Access Toolbar Datum display settings
W
# Print » WincawSetngs [ Show datum planes
— Licensing [ Show datum plane tags
a—ae
| Close Configuration Editor [ Show datum axes
[C] Show datum axis tags
[ Show datum points
Manage File L3
Show point symbol as: | Cross R
[C] Show datum point tags
Prepare 13
[z Show datum coordinate system
E Show coordinate system tags
Send » -
™ show images
Manage Session » L lons, notes and i display seftings
[T] Show dimension tolerances
Help [T] Show note names instead of note text
[T] Show reference designators of cabling, ECAD and piping components
[Z Show annotations and Annotation Elements
E{ Show annotation orientation grid
Set grid spacing to: | 0.100
Assembly display settings
Model Properties
0= BB E v Model Properties =
B Y materials
File= || Model | Analysis | Annotate Render Tools View  Fle: Materia Not assianed change
Units: Inch lom Second (Creo Parametric Default) change
D Hew Prepare model for distribution
b Acouracy Relative 0.0012 change
IZ; open Model Properties Miass Propertes ) crenge (%)
Ecit model properties.
(. Retations, Parameters and Instances
5
Ej save Mod¥CHECK Intel 5 Model Properties Reletions Not definect ) change (v
eneralg s madel in =y
L—E caveas » omembiNor ot Ell macel properties Parcmeters 2 definedt (7} change ()
£}, ModelCHEN Rege Instance ot cefinect Active: Generic - E8 change
% Print v | Ly Revenerste thymosel and genersts the Mode!
Check information report £y Features and Geometry
=9 Cose ModeICHECK Rule Check Tolerance ansi change
() © Display rules associated with this madel
Mames 7 defined changs
Manage Flle » | DA ModelCHECK Geometry Check G Toots
r@v:hecx moddel geometry for VDA, standard
Flexible Mot defined change v
DRM Session Report Shrinkage Hiot ciefinect (7] change (v
Generate & DRM session report
— , Simpliee Represertation 4ot Aclive: Vester Rep ) wiEER
Apply DRM Policy Profragram (7] change
Manage Session Define how to apply & DRM policy. Iterchange Not definect change ()
Help » Remove DRM Policies Model Interfaces
Define how to remave a ORM Policy P
Reference Control Defaut sefings chenge (v
Options Detail Options
Detail Options. change
K-
| ciose ||




View options

\DﬁauhﬁﬁaﬂHMH

Repaint

BACK
BOTTOM
FRONT
LEFT
RIGHT
TOP

L [T

Obiects

Spin Center

Create Cross-sections
for a drawing

/

[ View Manag%
Simp Rep | Xsec | Oriert | Al

==

Names

Symbolic Rep
(Geometry Rep
Graphics Rep

12



Sketching

) Constraint/ .
Rectangle Spline Relations Trim Apply/Finish
Fillet Point —\ Mirror
Dim
3 L 3 3
«| L0042 x JTINEH{O%E TS X

Line Arcs Text
e 3 Point Convert Cancel
Start Sketch e Tangent Entities &
Concentric Offset
Datum Plane

DI x x -

N RS S RN
NOTE: If you do not see all of these icons on your interface you can customize the toolbars to bring them
up. Right mouse button click on the top grey frame of the window and locate the “customize” option.

Where do you start a sketch?

Sketches can be created on any Datum Plane or Planar Face or Surface. Pro/E provides
you with three datum planes centralized at the Origin (your zero mark in space)

NOTE: Planes can also be created and will be discussed in more detail in the future. Also after completing
a sketch always select the Apply/Finish check mark on the sketch toolbar, this will activate the extrude or

revolve feature tools.

B OEgo- 8B 0] v E1 (Active) - Creo Parametric Student Edition = B %
Filev | Model | Analysis Annotate Render Tools View  Flexible Modeling  Applications ~PpO"@
iy ® " g . m A~ -
+ User-Defined Feature # Axis ] ofo Revolve o Project £ ’.\f O o
y b =
; 50 ol A . F°
" Copy Geometry « x Point ™ Ly Sweep ]
Regenerate , Pane | Sketen  Extrude Pattern Boundary Component
- (58 Shrinkwrap Ax Coordinate System & Swept Blend - Blend Interface
Operatians ¥ Get Cata ~ Datum ¥ Shapes ¥ Engineering ¥ Editing ~ Surfaces ™ Model lntent *
[ ® & ¢ B
Ellh =1 LS @0 %R
Model Tree L A=
J E1PRT
L7 RIGHT ERONT p
7 TOP ~ /'
h £7 FRONT e »,/’
2%« PRT_CSYS_DEF
+ Insert Here s AN
} \\‘ /
~ ABRT ¢sys D N,
. JBRT_CSYS IDEF TOP
b ~
| \ )’
RIGHT
@ [ ] 1] mart -

13



To start a sketch Pre-select the plane or face you desire to sketch on and then select the Sketch
NOTE: You can select the planes from the “Feature Manager”.

Icon.

Sketch Options —

o

1 Sketch ==
Flacement | Properties

Sketch Plane
Plane FRONT:FHDA.. | Lze Previous

Sketch Orientation
Sketch view direction

Reference  RIGHT:F1{DATUM PLAME)

¢ [ Ske‘tc:h\n Cancel |
~ L4

~ -

—

Controlling your geometry...

Pro/E uses two methods for constraining geometric entities.

Constraints and Dimensions

Constraints can be referred to as common elements of geometry such as Tangency,
Parallelism, and Concentricity. These elements can be added to geometric entities

automatically or manually during the design process.

Here is an example of adding
a relationship between two /
geometric entities.

ations Sketch
— ’l/"\
i
i Di
F P » ||
-\ = £
MNormal
L & [/ s
Constrain * Dimension *

14



Cautious sketching can save time.

There are 3 primary file types in Creo, which include...
1. Part (.prt)
Single part or volume.
2. Assembly (.asm)
Multiple parts in one file assembled.
3. Drawing (.drw)
The 2D layout containing views, dimensions, and annotations.

v &

Switching between documents (Activating a document)

~

oy |

l“ )\
NG
4

qu‘ . [;;] Y Y o v (

-

File » Model Analysis Aghotate Render To
; X k 7 .h g.":"-. W
™ E bre HAS ':]
o File _
?33 System v J-o Mode O

Select Construction
Setup ¥ GetData Operations ¥ Datum

Select the Window pull-down menu and you will see the available documents. Click on
the document you wish to work on from the list to “activate” it.

15



Sketch Constraints (Relations)

-ations Skerch
[}
boose e &
MNormal -
L </ Foe
Constrain * Dimension ™
Constraint Geometric entities to select |Resulting Constraint

Horizontal or

One or more lines or two or

The lines become horizontal or vertical (as

Vertical more points. defined by the current sketch space). Points are
aligned horizontally or vertically.
Collinear Two or more lines. The items lie on the same infinite line.

Perpendicular

Two lines.

The two items are perpendicular to each other.

Parallel Two or more lines. The items are parallel to each other.
A line and a plane (or a The line is parallel to the selected plane.
planar face) in a 3D sketch.

Tangent An arc, ellipse, or spline, and [The two items remain tangent.
a line or arc.

Concentric Two or more arcs, or a point |The arcs share the same centerpoint.
and an arc.

Midpoint Two lines or a point and a The point remains at the midpoint of the line.
line.

Coincident A point and a line, arc, or The point lies on the line, arc, or ellipse.
ellipse.

Equal Two or more lines or two or [The line lengths or radii remain equal.
more arcs.

Symmetric A centerline and two points, [The items remain equidistant from the

lines, arcs, or ellipses.

centerline, on a line perpendicular to the

centerline.

16



Controlling your geometry with dimensions...

Strong versus Weak
Dimensions -
Double click and
change to make
them Strong!

6.000

e 3000 ————=

Dimensioning this way will
enable the length of the
bracket to change but the
holes will always remain
positioned to 1.5” off each

t=— 1.500 3.000
O

6.000

O 3000 — =

Dimensioning this way will
enable the length of the
bracket to change but the
holes will always remain
positioned to the left side.

Ol ScE MR

1.750

N

3.500

1.750

‘-—1.500J = 1.500 —=

cations Skerch

Constrain  Dimension ™

17



Solid Modeling Basics
Layer Cake method

ey

-

Extruded Boss/Base (Creates/Adds material)

A

Extruded Cut (Removes material)

Ingredients:
e Profile

Revolve method

i |Revolve Boss/Base (Creates/Adds material)

sin | [4)

s Revolve Cut (Removes material)

Ingredients:
e Profile
e Center Line (Note: The profile cannot cross over the center line!)
oo e
L

— 1.000  |—

1.250

750 -



EXERCISE |
Introduction to basic part modeling

Base Extrude Features create a 3D solid representation by extruding a 2 dimensional
profile of the entity.

Objective:
Create a
solid

—

/|
This will fail to extrude.

AN

,Q<
L
1. Start a new “part”
file.

8B
Model Tree

[ E1.PRT
7 RIGHT
£7 TOP
£7 FRONT

3. Select the
Sketch icon.

2. Select the
“Front” plane.

‘When a constraint is active, right click to cycle through lockidisable/enable the constraint. Use Tab key §

L

= e . = B =
File + Model Analysis Annotate Render Tools View flodeling Applications Skeich D e N o
& iﬂ ! k W) @ ER S [<] = L_& ¥ X

e L] A = + N = i &

. File Select Construction Palette Normal Feature Cancel

#2  System . [O RV} L e Wl Requirements | 1IE
Setup ™ GetData Operations ¥ Datum Sketching Editing | Constrain ™ | Dimension ¥ Inspect * c

NN s N )

Seare Flere

N
N

This will create a hole.

’ 4. Select the
Rectangle tool.

R A it

ERONT

7. Click to finish
sketch.

sto R

6. Double Click
to edit the
dimensions.

5. Click and drag
across.

Ky 1 selected All

19




B O& RARCIE: NN E1 (Active) - Creo Parametric Student Edition = B

File » | I‘ Analysis Annotate Render Tools View Flexible Modeling Applications = D G M 0
04 P User-Defined Feature £ s (\l 7] i Revolve v (aaf Digwerer o Aokt S0 O [Eﬂl
0= =, @ x - =2

14" Copy Geometry o Point ¥ &e [ ]

R t Flane Sketch | Exct Component
N ¥~ [B shrinkwrap 2 Coordinate System &7 Swept Bien 7. SeleCt BOSS ) Interface
Operations ¥ GetData ¥ Datum * Shapes Extrude ks~ Modelintent

@ [¢

P % 7 e

Model Tree i - B2 - E[__.
O E1PRT
£7 RIGHT

L7 TOP
£7 FRONT
24 PRT_CSYS_DEF
74 Sketch 1
# InsertHere

| |
| \
| |
| \
\ |
| |
\ |
L |
. |
F g’ ® Coordinate Systems will not be displayed. . ﬂ 1 selected Smart -
NOTE: When dimensioning use the dimension tool and make edge selections, mouse center button click to apply dimension.
[T} O @Y v E1 (Active) - Creo Parametric Student Edition = B %
File v Model Analysis Annotate Render Tools View Flexible Modeling Applications Extrude o e N 0
O|Q gk~ X 4 C ||®Jmlﬁacr3|'}x Datum
Applies an anges you have made in the
Fpmenti| Ovfional] Properlies feature tool and dashboard
g LT LL)
gk 9. Hit “Apply
Model Tree - B -
il the green
£7 RIGHT
7 ToP
7 FRONT

2« PRT_CSYS_DEF

check mark to
finish.

8. Set to Blind

@ .5,

[§o| @ selecta sketch (if an internal sketch s preferred, the “Edit” option can be found in the Placement panel )

#

1 selected Sketch

20



% PRT_CSYS_DEF

& Extrude 1
& Insert Here

B OEE@o"«-8BF-9 E1 (Active) - Creo Parametric Student Edition
File v Model Analysis Annotate Render Tools View Flexible Modeling Applications
352 By Q@ userDefnedFeature 7 Axis . 7] sk Revoive f Hole 2 Drat v " + Extend 2 Proj
7 B+ W copy Geometry X point ~ {ysweep ¥  PRound ¥ (@ Shet 7] offset
Regenerate Plane _ Sketch  Extrude Pattern
- X~ (¥ Shrinkwrap % Coordinate System &P SweptBlend < Chamfer ¥ 1) Rb ~ - e Al intersect
Operations ¥ GetData ¥ Datum ¥ Shapes ¥ Engineering ¥ Edting ¥
2. @
Pem oty
Model Tree w-a-
D E1PRT
[7 RIGHT
L4106 Toggle views using
£7 FRONT

the “View
Orientation”

10. To sketch the
next feature select
the front face of
the model and
then select the
“Sketch” icon.

toolbar.

BACK
BOTTOM

Default Oriertation

Adding a constraint — Ctrl Select both left edges of sketch and solid. Select Coincident

File v Model Analysis Annotate Render Tools View Flexible Modeling Applications Sketch
= é k H W Yrhow @ 2 v FH + gt |H|E’ R" ¥ v X
2 % B~ B % R e N s} o
o Fie Select Construction . Palette i —. Normal Feature —— OK Cancel
& system - Mode Ov A O& Y Lo 2| Requirements |38
Setup ¥ GetData Operations ¥ Datum Sketching Editing = Constrain ¥ ion ¥ Inspect ¥ Close
= ® @ hB o S ey
B m® A& anmo DG e Er
Model Tree -8 -
(£ E1PRT
£7 RIGHT
7 70P
£7 FRONT

2« PRT_CSYS_DEF

& Extrude 1
% Insert Here
7% *Sketch 2

Constrain =
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Extrude

Placement | Option)

P Bm
Model Tree

O E1PRT
L7 RIGHT
7 T0P
£7 FRONT
%« PRT_CSYS_DEF

@ ~ ) v O v2 5‘ v ¥ E1 (Active) - Creo Parametric Student Edition
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications Extrude
O|A dk~bso WX 4 C N o/ifFH o0 v X

2. Enter .5”

» o Extrude 1
7~ Sketch 2
& Insert Here

» o7 ¥Extrude 2

1. Select the
Extrude icon.

7

W) | 1selected

Select the face, select sketch icon and draw a circle on the face. Dimension, Hit “Ok”

Setup * GetData Operations * Datum

L= ea)

Model Tree

[JE1LPRT
£7 RIGHT
£7 ToP
£7 FRONT
A« PRT_CSYS_DEF

LREEE

» 7 Extrude 1

» o Extrude 2
P InseriHere
#3% ¥Sketch 3

B O o280+ E1 (Active) - Creo Parametric Student Edition
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications Skeich

5 Ifj yk i V"")'.,\...-@E-@ ER |H|E‘ ﬂ" ¥ v X
o x Y OeQeyex R fut &

p Fie o | Select Construction . Palette - Normal . Feature —

&8 sysem B~ Mode -y R A e oLe 12l Requrements |33

Edting = Constrain * | Dimension ~ Ispect ~

Q& a @0, D% mE

oK ancel
Close
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Extrude Cut 4. Select the
Extrude icon. |
=] ; (o R IR o R ;'] ¥ E1 (Active) - Creo Parametric Student Edition PX4
File » Model  Analysis  Annotate  Render Tools View  Flexible Modeling  Applications Extrude _] 0
O/ A |4k~ |14 v %4 =1 Il 0 ixffier v X Lm
Iy —
g nent | Options | Properties
L 6.Selectthe | | 7.Select the “Apply”
M‘mlmg& f-8- . oelec e . oelec e pply
gl “Cut” and or hit “Enter” two
i reverse options. times.
%« PRT_CS
& Extrude 1
» g'E
7 Ski
»+n{ 5.Select the
» 7%g
“Through All”
option.
t e ) | 1selected Sketch v
Go to file save and save-as “E1”
B Oy -~c-82F -9~ E1 (Active) - Creo Parametric Student Edition = 8 =
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications . D e v 0
j;’ ¥ User-Defined Feature 7 axis f\; 7] oo Revoive Li" Hole 2 pran ~ trror ¥ Extend % Project ﬂ a a}\
o = ! Copy Geometry ' Point ¥ &7 sweep ~ <) Round ¥ Shel Trin Thicken [
Regenerate Plane Sketch Extrude Pattern Boundary Component
- % v (M Shrinkwrap Zx Coordinate System &7 SweptBlend i Chamfer ¥ &/ Rib ~ Blend ) Interface
Opj GetData ¥ Datum ~ Shapes Engineering ¥ Editing ~ Surfaces *  Modelintent *
@& S @0 % E
Y
Update or Regenerate model
changes using the
“Regenerate” button.
Although it is unnecessary in
this instance it is still a very
important tool. It will update
only dimensional or feature
changes made to the model.
- i Smart -

Now try LAB1...

NOTE: Patterns/Arrays and Mirroring will be covered in the next three chapters. Please try to model LAB 1 without using them. It’s
good practice to just dimension and sketch all geometry when first starting out learning this software.
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EXERCISE 2
Revolved Features

Revolved Feature - creates features that add or remove material by revolving one or
more profiles around a centerline. The feature can be a solid, a thin feature, or a
surface.

Tips...

Centerline, Edge, or :
Axis of Revolution o

The profile should never cross over the centerline, nor should there be profiles on both
sides of the centerline.

our @@aL> . »
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1. Create a new part file (E2) and then start a sketch on the “Front” plane.

4

2. Sketch the following. Ctrl select the profile and the horizontal centerline, then
using the “Mirror” tool to create a % of the geometry and then mirror it to the
other side. Make sure you finish adding the dimensions.

2.50

0.25 F 040 —e=r=— (0,38 —=

i ! |
! ) H gl :
a1 L ----- ~2:00=1—=—-~=1 B e S e — (e L e ~¢-~-~-

I
I
\ - 0.25 )
I
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3. Select the Revolve feature icon. .1 pnselect the axis/centerline.

| File Edit View Insert Analysis Info Applications Tools Window Help

BEEeS@vey hEEEwrRAEFRQEsEEH ON

R

Oos w  @-mn % A C
Placement i

Options ~ Properties

g B |m|SR

(_Show v ][__Setings ~ ]

(7J PRT0006.PRT
{7 RIGHT

{7 TOP

{7 FRONT

%4 PRT_CSVS_DEF
% Sketch1
& Insert Here
sio *Revolve 1

AT r—

&
&

Rounds
4. Select the top and bottom edges and add a R.100” ?ﬁ is/fillets.

_‘% g Select an edge or chain of edges, or a surface to create round set.
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EXERCISE 3

Secondary Feature Modeling

1. Sketch the geometry as show below on the “Front” plane.

1.50

DIA. 1.5”

USE
TANGENT

LINES
N

075

,,,,,,,,,,,,,,,,,, 75"

_J_I DIA. 1.27

2. Extrude. Select Mid-Plane, 1”.

) PRT0008 (Active) - Pro/ENGINEER Student Editi

| File Edit View Insert Analysis Info Applications Tools Window Help

ent | ion (for educational use only)

DB &S e o B (R (B2 3
DR GsRcB oaaa itk

2copertis

-Plane
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3. DRAFT: Select the Draft tool, and then References, Ctrl select all side faces
of the model. Then Click on the draft hinges dialog box, and select the
Front Datum Plane.

CEB&5GR00 ) BB
IERRATHESS
D

Draft hinges ‘ i
FRONT:F3(DATUMPL... | Detzils.. o

Pull direction
FRONT:F3(DATUM PLAI |

x
x

K

X
-

Ga )
£ o
=
27

=

4, Select the top surface (LMB Click 2 x) on the model and start a sketch on it.
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5. OFFSET: Select the Offset tool. Then select Loop. Then select the face.

(T3 PRTO006 (Active) - Pro/ENGINEER Student Edition (for educational use only) == ECE==<=
File Edit View Insert Sketch Analysis Info Applications Tools Window Help

SRS m-AFERaAd s el @0 ad

2 e %0 SAMDEE & SN

9> Select an entity to specify an entity loop, or a surface to specify a contour,
g% Enter offset in the direction of the arrow [Quit] <CR>

EINo entity created.
o> Select an entity to specify an entity loop, or a surface to specify a contour. 3 Type =]

Select Offset Edge
§-ﬂ E ) Single

O Chan

P

3
@ Loop N~
m)
£7 RIGHT O~
/7 TOP ~ -
£7 FRONT N
4 PRT_CSVS_DEF o ¥
Sketch 1 ~ B
77 Extrude 1 Mo L@
H

7 Draft1
& Insert Here ¢
7% ¥ Sketch 2

Al -

6. Enter -.125 and to flip the offset direction.

(3 PRT0006 (Active) - Pro/ENGINEER Student Edition (for educational use only) [=Er=]
File Edit View Insert Sketch Analysis Info Applications Tools Window Help

B0 E o SR esik 80 a0
ghian@fPeRE a8 E g w

& Enter offset in the direction of the arow [Quit] <CR> -
BINo entity created.
52 Select an entity to specify an entity loop, or a surface to speci

© Entr cfsetin the drecion of the smow ] 125 g» Enter offset in the direction of the amow [Quit] .125 EINICH

5

(] PRT0006.PRT
£7 RIGHT
£7 TOP
£7 FRONT
244x PRT_CSYS_DEF
Sketch 1
7 Extrudel
05 Draft1
& Insert Here <
74 3% Sketch 2
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7. Select the extrude icon, and then set to cut and .125 depth.

[C} PRTO006 (Active) - Pro/ENGINEER Student Edition (for educational use only) =n(=RE==)
File Edit View Insert Analysis Info Applications Tools Window Help

v m - PAREERaAQds el &0 a0
17 S s % e
=% -

Oc &= -4 c % Il Ueo [v] X

Placement Options  Properties \
b [2]e|dr A
7 =t
[ r
H
/\/
*

] PRTDO0S.PRT
£7 RIGHT
£7TOP
£7 FRONT
A« PRT_CSYS_DEF
Sketch1
7 Extrude 1
0 Draft1
al ¢
& Insert Here
7 ¥ Extrude 2

1 selected ’ Sketch =

7. Select Concentric (Circle tool), then select the arc edge of the part.

lick to disable it. Press Shift + right click to lock it. Use Tab key to toggle active constraint.

~ v

Box Qo
4 Rl Rl

1

WG kI
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9. Trim the intersection.

10. Select the extrude icon, and cut .700” depth.

Oac @ X% [ rC %
Placement Options  Properties \
Ee

Pzl - g
;J'
/\/
®

[C1 PRT000G.PRT
£F RIGHT
£F TOP
£7 FRONT
A« PRT_CSYS_DEF
Sketch1
7 Extrude 1
b Draft1
Sketch 2 <
7 Extrude 2
& Insert Here »
7 ¥ Extrude 3

1 selected Sketch =
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11.

12.

Select the base of the pocket and start a sketch. Draw the following two
.375 DIA. circles, and extrude / cut “Through-all”.

DATUM PLANE OFFSET: Select the Top datum plane, then select the
Datum icon. Set to -4 offset.

[Z3 PRTO006 (Active) - Pro/ENGINEER Student Edition (for educational use only) (==
File Edit View Insert Analysis Info Applicstions Tools Window
e e ol

The “Datum” icon
can offset as well
as several other
ontions for creatina
§u (3 DATUM PLANE

Pacamsct | gy | Fopatis

References

OE RS G Qi o o By i G
L% w
gtch. (If an internal sketch is preferred, the "R

* Datum plands will be displayed.
o Select up to 3 references, such as plang, surface, edge orf

("1 PRT0006.PRT
L7 RIGHT
- F FRONT
-2« PRT_CSYS_DEF
Sketch 1
Fitopr? Extrude 1
s Draft1
Sketch 2 ¢
[ Extrude 2
Sketch 3
For) Extrude 3 »
‘o Insert Here
L7 EDTML

TOP:FZDATUM PLA... Offset

Offeet

Tmnslaﬁ% -4 :

I B P E g B
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13. Start a sketch on “DTM 1” and draw a .5” dia. circle centered on the
origin.

DTM1

14, Extrude boss and use the “Up to next” option.
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15. Select the circle and use the setting as shown in the illustration below.

EINICH

(7] PRT0006.PRT

{7 TOP

-7 FRONT

-2« PRT_CSYS_DEF
7 Sketch1

i) Extrude 1

- g“‘ Extrude 3
~£F DTML

& Insert Here
) ¥Extrude 4

(J PRT0006.PRT
{7 RIGHT
-7 TOP

47 FRONT
-2« PRT_CSYS_DEF
----- 7% Sketch1
G Extrude 1
..... ) Draft1
- Sketch 2
e Extrude 2
----- . Sketch 3
&7 Extrude 3
----- 7 Sketch 4
@) Extrude 4
----- & Insert Here

he

P
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16. Start a sketch on the front datum plane and draw a rectangle with the
following dimensions.

&

EINIQH

17. Extrude boss using the mid-plane option and .750 thick.
(3 PRT0006 (Active) - Pro/ENGINEER Student Edition (for educational use only) [ol& ==
File Edit View Insert Analysis Info Applications Tools Window Help
SENE ooy BEEEN O AEERQARd sl e o a0

L%l v
=1

O
Placement Options  Properties
| eleal

(] PRT0006.PRT
£7 RIGHT
£7 TOP
£7 FRONT
2%« PRT_CSYS_DEF
Sketch 1
b Extrude 1
2 Draft1
Sketch 2 <
-1 Extrude 2
Sketch 3
) Extrude 3 B
£7 DTML
Sketch 4
10 Fxtrude 4

&

#

\} DT

#

*
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18. Using the Draft tool select the following faces and front plane and put 7° of draft
on the side faces of the handle.

| Fle Edit View Inset Analysis Info Applications Tools Window Help
OISy Gy G ey o By (5 [ e

®aa@stshmes ol

A Lo CINIQH

- 2x PRT_CSYS_DEF
7 Sketch1

i) Extrude 1

&) Draft1

777 Extrude 2
. Sketch 3
i-cf? Extrude 3
/" Sketch 4
i) Extrude 4

19. Rounds: Select the rounds/fillet icon, then select the edges as shown in the
illustration below. Add .100”.

D g
e o0 - I Yoo [v] X

Sets Transtions Pieces Options Properties

o

(7 PRT0006.PRT
{7 RIGHT

,,,,, 7 TOP

..... g FRONT

-2« PRT_CSYS_DEF
</ Sketch1
@7 Extrude 1

77 Extrude 2
----- 7+ Sketch 3
) Extrude 3
L7 DTML

----- 7 Sketch 4
-7 Extrude 4
----- . Sketch 5
@7 Extrude 5
%) Draft 2
..o Insert Here

...... -Q *Round 1
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20. Add .060” Rounds to the following edges.

FINICH

(7] PRT0006.PRT

47 RIGHT

{7 TOP

-7 FRONT

-2« PRT_CSYS_DEF
. Sketch1

i) Extrude 1

i-¢77 Extrude 3
{7 DTML
. Sketch4
i) Extrude 4
/. Sketch 5
i) Extrude 5

Finished
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EXERCISE 4
Secondary Feature Modeling

1. Sketch the geometry as show below on the “Front” plane. Then Trim.

8. Revolve.

[J PRTO0006 (Active) - Pro/ENGINEER Student Edition (for educational use only)

[E=3[oB 7
File Edit View Insert Analysis Info Applications Tools Window Help
NGRS e rewml AR QAd 2R e o o0

£ je Xt X TLIW
oéb £

L:J@ 1Curve v 00 <~ 4 ] [

Placement Options  Properties
S

(7] PRT0006.PRT
£7 RIGHT
/7 TOP %
£7 FRONT w R
2¥x PRT_CSYS_DEF
7% Sketch 1
= Insert Here
oo *Revolve 1

1 selected Al
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9. Constraints: Select the Front datum plane and sketch the following. Use
the Constraint tool and select the Tangent option. Then select the left
most horizontal line and the arc attached to it to establish a tangent

relationship.

[ Constraints [s£3s]

=) ]

o & e

=

...........................

Close

10. Sweeps: Use the pull-down menu “Insert/Sweep/Protrusion” Select the
left side of the curve we just created to create a new sketch datum at the

end.

11. Also select: “SelectTraj/Curve Chain/Select All/Done/Done”

@ Select an edge from chain, pick 'Done’ when finished.
* Model will be displayed in wireframe display.

o Select a curve from chain.

o Select chain option from the menu.

B=EE
|

EU

(7J PRT0006.PRT
£7 RIGHT
£7 TOP
£7 FRONT
2¥x PRT_CSYS_DEF
Sketch 1
2 -:»:-2') Revolve1
7% Sketch 2
% Insert Here
& *Protrusion id 126

r

3 PROTRUSION: Sweep

[l

Element Info
Trajectony Selected Traje
Attributes Free Ends

= Section Defining

] 0 - P

£ Define Refs || Info |

-
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Draw the following sketch and select the “finish” option once complete.

i
"

———

13. Pattern Circular Pattern: 360°/3 = 120° (NOTE: First select the spoke to
activate the icon.) Select “Axis” also select the “ "

" J PRT0006 (Active) - Pro/ENGINEER Student Edition (for educational use only) ==
File Edit View Insert Analysis Info Applications Tools Window Help

e W REERARsEshE 60 o0

14 y Y ]

= - L A 4 .
‘ Auds = |5 Tiemisiay, 4 3_’_1260 v /& [36000 . ‘21 x

Dimensions  Table Dimensions  Referenc Tables  Options  Properties

BREE,

)
g
'l 15
(] PRT0006.PRT 4
£7 RIGHT ~ =
7 TOP x
£7 FRONT ~>< X
44 PRT_CSVS_DEF ¥ Il
Sketch 1 A ABNE
[#-ofo Revolve 1 \ wa (bl
7% Sketch 2 b B
% Insert Here 3 A
(2] ¥Pattern 1 of Protrusion L t‘ 3 l
> =

“ [ 1sstected s =
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14. Fillet all edges at .125”

B
= EINIQH [v] x
Pieces Options  Properties

() PRT0006.PRT
47 RIGHT
L7 TOP
-£7 FRONT
-2 PRT_CSYS_DEF
</ Sketch1

7% Sketch 2

g‘ Protrusion id 126
& Insert Here

) *Round 1

S B
© @

< » &0 %@5‘@

| —l [ 1

N &
o o
7
() PRT0006.PRT !/ %
{7 RIGHT r~
L7 TOP .
~4F FRONT :" Q
- 2%« PRT_CSYS_DEF e e
-/ Sketch1 2
(oo Revolve 1 (Bl
% Sketch 2 : 90 &
@[] Patternl of Protrusion [ 0 SRR G
& Insert Here
-‘\) *Round 1
(=]
&
| — [N -] &
- _ .|

47



15. Select the “Front” plane and start a sketch on it. Rebuild after completion.

3 PRT0006 (Active) - Pro/ENGINEER Student Edition (for educational use only) o= ]
File Edit View Insert Sketch Analysis Info Applications Tools Window Help

5 E s A2 RE T
ENENE W) - PRgaa@sFsRk 0 a0
Xy g, O Iag Lo | dE BT A

A% PuEE s a R G g

= When constraint is displayed: Right click to disable it. Press Shift + right click to lock it. Use Tab key to toggle active constraint,

o> Select two entities or vertices to align.
o Select two entities or vertices to align.

S

(1 PRT0006.PRT
£F RIGHT
£F TOP
£7 FRONT
A« PRT_CSYS_DEF
Sketch1
=t Revolve 1
% Sketch 2
[z] Pattern 1 of Protrusion
“ Round1
& Insert Here
; Sketch 3

________i-.)_____.}_

EINIQH

16. REVOLVE

R

(1 Thus Wi [v] X
] Placement Options  Properties
JENEES E

-Shgw b __ée'mngs '7

7
(] PRT0006.PRT y
£7 RIGHT A~
17 TOP .
£7 FRONT xx
%4 PRT_CSVS_DEF s
Sketch 1

i Revolve 1

Sketch 2

Pattern 1 of Protrusion
Round 1

7% Sketch 3

P Insert Here
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17. Add .250” Rounds to the spoke — handle sections.

s»ewmksmwyssmwmmwsmmm

oe l l ﬁ % oy BEEEZHCHBEFRAREsR o 6 g0

EINICH

T
] [l ] )

() PRT0006.PRT

~£F FRONT

- 2¢x PRT_CSYS_DEF
-/ Sketch1

oo Revolve 1

% Sketch 2

#-[::] Pattern 1 of Protrusion
-+ Round 1

. Sketch 3

#-ofo Revolve 2

& Insert Here
-Q #Round 2

FINISHED
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EXERCISE S5
Bottom-Up Assembly Creation

1. Go to “File/New and select the Assembly Template”.

ERR Student Edition (for educational use only)
ﬁb Applications Tools Window Help

o‘.}e =R EEENO-BEEwAaaA@s FesR e o gl

.
0
[—]ﬁ —¢ 3 New =) Al
- Nams’™
Show Type Subtype 7 @
(0) §E Sketch @ Design ’f: &
[T ASMO002.A5M o () Interchange
© Part - ~
. () Verify
@ Assembly () Process Plan Y -
® Lu Manufacturing () NC Model )
® Perm Mold Layout eSS
[ ©) Ex. Simp.Rep. s
@ [ Format - mp Rep -1
© [H Report DZ
© -E Diagram =
©@F ot |l
4 @ @ Markup &

Neme

Common Name

Use defautt template

2. Assembly Tools.

E—ll—llj- % Assemble (Bottom-Up)
E i % Create (Top-Down)
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3. To insert a part into the assembly select the Assemble icon. Select the
Sheet_Metal_Bracket.prt, and hit the “open” button at the bottom.

ASMO002 (Active) - Pro/ENGINEER Student Edition (for educational use only)
File Edit Wiew Insert plications  Tools Window Help

BrEEEw- AR Rl ¥eshE 8 0 od

x|
!
ASMO002.ASM i
~4
P
(C] < Users » Chris » Deskiop » ProE WidFire » Sample Files » ProE E5 v*z
~ Zx\
)
Common Folders o dbracketpt wemw e
[H] In Session E uank-arrw’
Desktop AR am
lednob prt
@ My Documents ( eranicknob
(1 crank-shaft prt
B Working Directory [ spiderprt
Network Neighborhood 7 ujoint_pin.prt
% Favortes (] uioint_pinZ prt
universauuint.asm
(71 yoke_female prt
(1 yoke_male prt
File name: bracketpt Date modified: 22-Jul-09 03:36:34 PM Preview ~
Fie name: Type | Pro/ENGINEER Files ( v [subtype -]
Folder Tree . [ Open [+][OpenRep...|[ Cancel |

4. Select the Automatic pull down and select the Default option.

lysis Info Applications Tools Window Help
ooy BEFELHO-REIFTRAQAQ S SR
AR

r auto type constraining.

@’j\, User Defired v

Placement Move Flexhbiity Properies

v NOT DEFINEI - A STATUS - N

ANEIE, &
Show ¥ Settings ¥ @
[T] ASMO002.A5M
=k
5. Select the Assemble icon and then insert the yoke_male.prt.
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6. Select the radial surface of the yoke_male shaft and then select the surface
of the hole on the bracket.

3 ASMO002 {Active) - Pro/ENGINEER Student Edition (for educational use only
File Edit View Insert Analysis Info Applications Tools Window Help
DEESG oo BEEELSHOCREFINRAAAYS SR
Bo00aiiakine
E’J o Select any reference for auto type constraining. :
(][] © [vserDeined v || [Automatc ~ | [0~ MOTOEE -] £ STATUS o Consirants nlvx
Placement Move Fledbiiy  Properies
b
Show ¥ Settings ¥
ASMO002.A5M
“[ ) DBRACKET.PRT
BRACKET:Surf:F2{NEUTRAL)

Notice the alignment that takes place.
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y 4

8.

Select the Placement tab and then select New Constraint option. Then
select the top surface of the yoke_male, and the underside face of the top

flange of the bracket. Note: make sure you deselect the Allow Assumptions icon to
enable dynamic assembly motion (it’s located at the bottom of the Placement tab).

ASMO002 (Active) - Pro/ENGIMEER Student Edition (for educational use only)
File Edit View Insert Analysis Info Applications Tools Window Help

e Ee S %iﬂﬂ%‘%ﬁ‘s‘é‘:—‘ﬂﬁijv@@%5‘@7@\@\@@@5@5
o000 g 4Aa%T N

ey & Select any reference for auto type constraining.
@{ T_\,‘ User Defined v| [Moma‘.ic v]v A
Placement Move  Fexbility  Properties
?E = Set2 (User Defined ) Constrairt Enabled
Insert

o Consat Toe

0 YOKE_MALE:Suf-F2INE | Autematic | [Fip]
Select assembly item

A Vo —E

Status
Partialy Constrained

New Set

After applying the last constraint try moving the component using the Drag
Component icon. Click on an edge of the yoke and drag with the left mouse
button. It should spin in place only.

LI I s [ s

Show ¥ || Settings ~

A5SMO002.A5M
(] BRACKET.PRT
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9. Insert the spider.prt and mate the cylindrical faces of the holes.

VOKE_MLE:SurF:FZ(NEUTRAL]

| =l

! AUtomaric

10. Select the side face of the spider and then the inside face of the male_yoke
leg. You may need to rotate the assembly to see the correct faces. You may

need to Regenerate after applying the last mate.

a
st
n:

e

Automatic "‘-.,‘
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11. Select the concentric holes. Select the yoke_female leg and open face of
the spider.

type constraining.

ned v v [NOTDEFINEI | L STATUS : No Constraints
Properties

Constraint Enabled

E I.

Status.
No Constraints

i
VOKE FEMALE:SurtF2(NEUTRAL)

12. Use the Drag Component tool to locate the yoke_female near the bottom
angled flange of the bracket.
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13. Editing a Mate: RMB select the Spider from the feature tree on the right of
the screen. A pull-down menu will appear. Select Edit Definition.

(7] BRACKET.PRT

T YOKF MALEPRT

0SPIDER,PAY.

Activate
Regenerate
Open
Representation 3
Delete

Group

shPE N,
J Edit Definition &
S L 4
Mg Figpi >
Edit References
Pattemn..
Replace
Reference Control

Fix Location

Setup Note »
Send To 3
Info 3
Hide

Edit Parameters

14. Parallel Mate: Select both bottom faces of the yoke_female and the angled
flange of the bracket. Then select the Orient to assembly reference option
to align parallel. (Parallel is needed here because there is a small gap between the
parts.)

—

BRACKET:Surf: F2(NEUTRAL)
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15. Insert the u-joint pin_2.prt, and select the cylindrical faces to mate.

16. Distance Mate: Select the end face of the pin and then select a parallel flat
face the spider. Add a distance of .35”

[NOTDEFINEI - | 34 STATUS : Pattially Constrained

“ uEEy »
R A S
‘ '= 035 &~ % STATUS : Partialty Constrained
e Tgmn®
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17.

18.

Attach the remainder of the components.

After completion you should be able to use the Drag Component icon to
dynamically rotate the assembly.

Finished
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EXERCISE 6
Fundamental 2D Drawing Creation

1. Open the “Exercise 6” part file.

File Edit View [nsert Analysis Info Applications Tools Window Help
o B b B L 08 O
DEESEQQ 0 - ¥ B B[S IT W
r ox. vy TH
|7 ;)(a‘% Lis
© Datum planes will not be displayed. B ‘ = |
e i
EA &
Model Tree Ei A= ‘
[ 3 EXERCISE_6.PRT
£7 RIGHT
£ T10p

£7 FRONT
%4« PRT_CSYS_DEF

sk Revolvel

s Revolve 2
P "Round 1
*Shell 1
*Shell 2
Shell 3
) Round 2
) Round 3
<) Round 4

#- (] Pattem 1 of Extrude 1

+- (5 Pattern 2 of Extrude 2

2. View Layout/Drawing Toolbar. Make sure Exercise 6 is shown in the
“Default model” box, and select Empty with format, then select
a_format. You may need to browse to find the part if it does not show
automatically.

. | Elmm———m——s
@@" ¥ UserFormats » v |¥3 Search
i s

r Default Model
Eiljj Organize

—— ——]
|EXERCISE_GPRT | | Browse... |

Common Folders [ dte_formats
— Specify Templ ) In Session (C1sample_formats
‘;:‘ lﬂtemat\ Deskiop £3a31_formatfrm
@ Empty with form £3a2_formatfim
£ My Documents
&Erm o £3a3_formatfrm
e cs-pe £ 3ad_formatfrm
Format 2 - -y (% Working Directory oMNgait frm
‘ a_formatfrm 'Lv] | Browse... | " Network Neighborhogd | ©oid m
-

—_— (& Templates FRE - Ly
£3b_formatfrm

ProiLibral

i & fd ¢ formatfrm
System Formats £3d_formatfrm
User Formats

2 Favorites

File name: a_format.frm Date modified: 17-Aug-10 12:41:48 Pk Preview ~

File name: | a_format.frm | Type ‘ All Files () "

[ Cancel I » Folder Tree Cancel




3.

The standard a sheet should automatically show up.

O2B o - {aBx- sk WENE B -0 @akk W
Layout Table Annotate &etm‘Rwew Publish

File Edit View Analysis Info Applications Tools Window Help

Drawing

‘@ F7 New Sneat H a_ rgi
oy @ s e

Models T Move or Copy Sheets Mgy Wil Auilary £ Convertto Draft Grou
Dooument Model Views -

ection... (! Drawing Vi

£ Show Hoaifed Eages 22 overiy.

€] object.

Inset v

I é (A component Dispiy. | |1 craon |
T : 2

General,

~ Drawing Tree

~ Model Tree

EXERCISE_6.PRT
L7 RIGHT
£F TOP
L7 FRONT

oo Re

) "Round 1
"Shell1
E "shell 2
Shell 3
<3 Round 2

* Loading 2 tolerance tables.
D %

Sheet 1 of DRWOOOL.DRW

24 PRT_CSY5_DEF
% Sketch1

v

Eo i B

To insert views RMB (right mouse button) click/hold in the center of the
drawing. Or select the “General” icon in the “Layout” tab tools ribbon.

Select “insert general view” from the list, and then left click to drop the
new view in.

Select the “FRONT” option from the “Drawing View” dialog box and hit

OK. NOTE: If you lose the “Drawing View” dialog box simply double click
on the drawing view itself to return it.

Categories View type
View Type
Visible Area
Scale Type | General ‘
Sections e
View States View ori

View Display Select orientation method @ Views names from the model
Origin () Geometry references
Alignment () Angles

Model view names Default orientation

| [Tnmemc 'l

View name | new_view_2

Standard Orientation . X ang\e‘ 0.00
|| Default Orientation

Yangle 0.00
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7. To move the views select the view then RMB click the “unlock view”
option.

8. Projection view: Select the front view of the part then select the
“Projection” option in the “Layout” tab ribbon.

Layout Table Annotate Skeich Review Publish
—

| @ #7 New Sheet || [ ¢ o_ PrD)ectiDn.ﬂ Drawing View... H % Compenent Display... H L Graph... |
o £ Sheet Setup @ ?D D4 [0 Show Modified Edges L' [ Edge Display. 4Z Overlay.
rawing ine
General =
Wodels () Wove or Copy Shests neral <% Auxilary.. [ ConverttoDraftGroup  Sive 10 Amows.. 9] Object.
Document Model Views. A Format - Insert -

g Select CENTER POINT for drawing view.

A =
~ Drawing Tree -

Sheet 1 of DRWO0OL.DRW
new_view_2
g top3

1 selected I:

~ModelTree [ (v T~ [~
EXERCISE_6.PRT - |k
£ RIGHT
7 TOP
~£F FRONT
A PRT_CSYS_DEF
] sketch1
gt Revolvel
£ Sketch 2
~ohs Revalve 2
- "Round 1
"Shelll
(] "Shell 2

9. Section Views: Select the top view and repeat the projection view
steps, and then move the pointer up, LMB click to drop the new view.
Then double LMB click on the view to activate the options of that view.
10. Turn on/show the “Datum Planes”

Ao -0 @4 2%
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11. Section Views: Select the section option, in the menu manager select
“Done”, and then create new, then type “A” in the text box and hit the

Categorii
View Type

Visible Area

View Display
QOrigin

Section options

() Mo section
‘ 2D cross-section
(O 3D cross-section
() Single part surface

|7 [ Show X-Hatching

E |E| |Z| Model edge visibility @ Total ") Area

Alignment N
| Hame Sectioned Ar. Reference

green check mark at the right of the screen. Then select the Plane option

to the right, finally you can select the actual plane (horizontal) on the

top view.

rawing View.. || % Component Display,- 1T

Drawing View

how Modified Edges "LT [ Edge Display...
ine

onvert to Draft Group Style... EEI AITOWS...
- Format

Categories

Section oplions

() No section

@ 2D cross-section

() 3D cross-section |

g

Alignment

X odel edge visibility
(e ]

Name Sectioned Ar. Refe

Create New.. "| Full

EINICH
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12. Section view arrows: You select and RMB click on the section view, then
find “Add Arrows”, click on the Top view and they should appear.

SECTION A-A

13.

Detail View: Is added by selecting the “Detailed” tool in the “Layout”
ribbon. (NOTE: Do not pre-select the view.)

DS Ei - o

BX-isghiNEHBIER-0i 4 2% Eile Edit Viev
J:Laynut | Table Annotate Sketch Review Publish
@ E New Sheet En Projection. g Drawing View. Component Display.. [~
o £ Sheet Setup... = Detaiied... () Show Modified Edges ||~ L— " () Edge Display. 4£Z Overlay...
rawing ine
Models T Moveor Copy Sheets | o' G auary.. () Style.. 50 Arrows. Object..
Document Model Views - Format - Insert v
# Select CENTER POINT for drawing view. n:5) Detailed
En % Create a detailed view
~ Drawing Tree ﬁ -
Sheet1 of DRWOOOL.DRW
) new_view_2
Ba top_3
O, top 4
A

14, Select a center point for the view, and then sketch a spline around the

area, and center mouse button click to close it. Then click to the right of
the screen to locate and drop the new detail view.

—3SEE DETAIL A

SECTION  A-d

DETAIL &
SCALE 1 oop
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15.

Auxiliary views: Are created by selecting the option then selecting the
edge of the flange on the front view. Then select the drop point. Double
click on the view to change its appearance.

16. Isometric General Views: Are created when you select the general view

icon. Then select the location to drop the view. Double click on the view
to change the appearance.

Drawing View

Categories
Visible &reg ~ Viewname new_view_9
Scale
Sections

Vi States View orentation

View Displ ~
Origin lect orientation method @ Views names from the model

Alignment () Geometry refe

P Trences
) Angles
Model view names Default origngzyl

Standard Orientation - Xangle 000
Default Crientation —
BACK
BOTTOM
FRONT
LEFT

View type

Type

Y angle | 0.00

4

17. View Display: Can be used to change the views from solid to wireframe

or hidden lines/HLR

Ve 302y cotera
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18. Dimensions and Annotations (2 Methods): Select the “.
a. Import (Show Model Annotations) dimensions used to create the model
b. Create (New References) dimensions (Note: reference dimensions
cannot be changed)

Sketch Review Publish ) ::
= S YR =T Réwew  Publish
g7 | '

aemmtes | Wy IR Y S A [ Ao
i} Decimal Places... Show Model _ _ R
o Annotations| 2\ @ [m E [T - i i HwW Gy o == Snap Line.
- - | - Show Mode
‘arameters nsert hd -
Annotatiol "™ Dimension - New References D

FRET ¥4 Show Model Annotations

Create dimenzions using new references.

Show annotations from the model.

=

19. When importing dimensions try using the feature/view option versus
inserting all the dimensions for the mode as it will cluster all them
together. Feature helps reduce the cluster and yet the dimensions are
editable, providing the benefit to edit the actual parts and assemblies in
a bi-directional fashion from the drawing.

0fH ©-a-YBEX- gRlpE B Ee-A gakxle
Layout Table Annotate Sketch Review Publish

Eile Edit View Analsis Info Applications Jools Window Help

s || #8 swron Dimensions ||y Ay B ][ < of atachment.  «f» Transite || = Armow Styie |
L S T L Snap Line. Eovetoview [N Rotste %
48 Decimal Places... || Show Hodel T
Annotations 7 ® [ fE [T~ Cleanup Dimensions 4. 110ve Special - [7] Scale Style.. S wray
- Paameters — - L -
= Showing feafure & (REVOLVE 1) in part EXERCISE_6. 1 selected
D %
- Drawing Tree -

Sheet1 of DRWOOOLDRW
]

new_view_2

~ModelTree [ v i~ [~
EXERCISE_6.PRT -
L7 RIGHT
L7 TOP
L7 FRONT
2 PRT_CSYS_DEF

fo Revolve 1

Shell3
ESW ST | M

20. Editing the Sheet: use the “Note” tool to enter your name and part
number.
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21. Printing: Select the “Publish” tab for print and print preview options.
Note if you find it difficult to print using the Pro Engineer printer tools
select the “PDF” option and print from Adobe instead.

IDEQ o - 2R X- S5k WOHNE B8 -0 g L%l

FEile Edit View Analysis Info Applications Tools Window Help

Layout Table Annotate Sketch Review F‘u

|@ PrintPiot ) Medusa () DWG () CBM

Obpxr  OIEs (O stheno O TIFF

Seftings Close Preview  Print

OroF  OsEP O SET
Publish

r |
EXERCISEE ‘

SEE DETAIL A

&

DETAIL A
SCALE  19:43

| e A R [seet 19,98 [ameer 1or
T

22. Transitioning from Radius to Diameter when dimensioning, is simply
done by double clicking on the desired edge then middle click to drop a

Diameter dimension. Versus a single click on an edge will resultin a
radius.
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MODEL MAME TITLE

PRTO001

3.000 —=—

@3.000 —

10.000
7.000

6.000

————— 15000

5.000

NOE: MODEL RIS PARY 1N PRONE, AND THEN CREATE

THE DRAWING.
DRAWN BY DATE
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TITLE
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EXERCISE 7
Projected Curves and

Sweeping

1. Sketch this on the “Front” plane.

R1.500

[ ¢

4000

2. Hit “Done” to exit the sketch.
Select the “Right” plane and start a sketch on it.

Draw the following.

w

B

b
®
5.

Hit “Done” to exit the sketch.
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6. Extrude the curve Mid-Plane 4”.

check to apply.

0

Olafg~ks_MxX A L

Placement  Options  Properties

B |& e |8

[J PRTOOD1.PRT
A7 RIGHT

7. Go to. Then go to Edit/ Project.

"

L ey Py Ty

File | Edit  Wiew Insert  Analysis Info  Applications
D E“’ Regenerate Chrl+35
ljl—,’] Undo: Yalue Change  Chrl+2
Redo Chrl+y
dh cut Chrl+
Copry Chrl+C
% [B Paste Crl+v
Paste Special...
3 Mirrar .
Elip Mormal. ..
Fill...
5l Inkerseck. ..

.MI

. @ Trirm. . %ﬁ Project
Eebend | proiect Tool

T] Offset,..

It should extrude as a surface. Hit the green

EINIQH

73

By B K

x
x




8. Select References/Project a sketch/Sketch1-Curve that you drew/CTRL
select all surfaces/Select the Front Datum/ Flip the arrow

Ele Edb Wiew Insert Analysis Iofo Applcations Tools Window Help

= . H = ua -
DS80S G oo § B FHIE M
~
/A7 | @pSelect a plane, an axis, a coordinate system axis or & straight entity ko specify the projection direction.

| 4

[%][ "1 Prane

Surfaces [1 itemls) | Direction | 4long direction

Refarences  Propelies
§a|— Project a sketch.

Shg Sketch
Skelch 1

Surfaces

Individual Sufaces

:
" Direction Fisference
4.7 [ FRONT:FIIDATUM PLAN

HProject 1

B PRT0001 (Active) - Pro/ENGINEER Educ

analysis  Info  Applicat

Filz  Edit
D E 8GR oo

Eard
A | gy Select a plane, an axis, a coordinate system

Sulfaces [ 1itemist” |

Froperties

View  Inserk

¥ My Desktop [X|

- [,

1 selected All

Diirection E

References

Sho Sketch
| Sketch1

A&7 | Unink |

Surfaces /

Individual Surfacese”

Details...
Drirection Reference
[ FRONT-FIDATUM FLANE|  Flip |

* N E = A= w

RN

x
x

RN S

L

B & @
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9.

10.

Select the surface and RMB click to find the “Hide” option.

You should now have a single 3 Dimensional curve.
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11. Hit the “Done” icon and Sweep/Protrusion using the curve as the Path and
the circle as the Profile.
12. Also select: “SelectTraj/Curve Chain/Select All/Done/Done”

PROTR O NEED PROTRUSION: Sweep
Element Info
|E|ement |I_nf0 | > Trajectory Difining
1 | > Trajectory Drefiring Sention Required
Section Fequired

[ Define Info
i3 Fieview

Menu Manager

Define [ Refs ][ Infa
Ok,

w DIRECTION

Cancel Preview

Menu Manager

w CHAIN

one By One
Tangnt Chain
i Curve Chain - [JESSS A A
Bndry Chain
Surf Chain

Intent Chain

Unselect
Trim Extend
Skart: Poink

Done

Quit

Select 1 item.
13. Draw a .500” circle at the intersection/end of the curve. Select “Done” and
llOKII

D75 5

& PROTRUSION: Sweep [X]

|Element |Inf|:|
Trajectony Selected Traje
> Sechion Drefining

]
[ Define Fefs ][ Infa

Fresiew
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17. Start a sketch on the “Front” plane. Draw the following.

R
45000 7 000

~

\ R1.000

18. Select “Done” to exit the sketch.



19. Select Sweep/Protrusion using the curve as the Path and the circle as the

Profile.
20. Also select: “SelectTraj/Curve Chain/Select All/Done/Done”

21. Select the concentric circle icon (buried under the circle tool). Select the
edge of the face and click over the edge to assume an “Equal” diameter
(R1/R1)

= promuson:Swesp )]

|Element |Info
Trajecton Selected Traje
"

x 5 ;}gé I:I£ 2al F:l 0| attibutes Free Ends

» Section Defining

>

<
Define Refs Infa
] ] EanceIJ
X
Select 1 item.

ak. Cancel
O

>

A
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22. Sweep using the new path and converted entity as the profile.

22. CTRL Select both Protrusions from the Feature Tree, and then select the
Mirror icon. Then select the end face of the body.

(73 PRTOOO1.PRT
£7 RIGHT
- £7TOP
£7 FRONT
- <PRT_CSYS_DEF
L Sketeh 1
o 12
i+ dt."lE\tlUdE 1

i &Project 1 /
% Sketch 3 g

& Insert Here
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23. Now using the tools you have learned over the past 5 weeks finish the

remainder of the model.

Hints to complete the model...

o 2 O

-4

SECTION A-A

24, Revolve “Two Directions”

E~ So— o a -
Flacement | Optons  Properties
gm Angle

Side 1| Lk varsble  |v| k500 [v]

Side |4 Fvaisble | v|[135.00

----- [ Capped Ends

----- 5 Sketch 2
- Extrude 1
E]---% Project 1

----- g" Protrusion id 161
----- % Sketch 3
Protrusion id 265
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Fle Edt View Insert Analysis Info Appications Tooks Window Help ; ‘

DE0BGR vo) bEEN | DrFQa0s "ol 6000 2 Aa%3®
» Features mirrored successfully. S |
D Select eye target with middle mouse to initiate Fly
D Use (Middle Mouse Button) to orient a Wiew.  Exit Orient Mode to terminate.

|2 m a0

Show v | Settings v

(73 PRTO001.PRT
£7 RIGHT
£7 T0P
L7 FRONT
A PRT_CSVS_DEF
1 Sketch 1

x
x
e

e
.

@ \

[ % Project 1 S
2 Protrusion d 161 p‘,
Askechs (I A S T 7 .

Protrusion id 268 1

g immr 1

&7 Protrusion id 313
&' Protrusion id 408

& Protrusion id 558 :
& Protrusion id 653
& Protrusion id 680 -
&' Protrusion id 775
# oo Revolve 1(2)
# Insert Here

[

BHea &

Er—

The completed part; check to see if your feature tree looks the same as this one.

(1 PRTOODT,PRT
- £F RIGHT
T TOP
< F FRONT
- 3« PRT_CSV¥S_DEF
Sketch 1
Sketch 2
G- Extrude 1
[]---,% Project 1
g Pratrusion id 161
¥ Sketch 3

@ Protrusion id 263
[—]ﬁz Mirrar 1
& Pratrusion id 313
& Pratrusion id 408
Sketch 4
Sketch 5
[+ s Rewolve 1
= 1t Mirrar 2
g Pratrusion id 558
g" Protrusion id 653
g" Protrusion id 650
& Pratrusion id 775
ot Revolve 1(2)
- ap Insert Here
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EXERCISE 8
Swept Blend/Lofting

Swept Blends create a feature by making transitions between profiles. A Swept blend
can be a base, boss, cut, or surface.

Objective: Create
a boat hull by
lofting multiple
section profiles.

1. Create 4 datum planes beginning from the “Front” plane and offset from
each other as shown.

DTM Plane 1 —6.00”

DTM Plane 2 — 8.00”

DTM Plane 3 —1.00”

THe2

&.000

1.000

2. Sketch 1 on the “Front” plane should look like this... use the Spline tool.

L

oonp  1.500 1.250

i

—= = 500
1.500

2.500
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3. Sketch 2 on “DTM 1” should look like this...

! f
2.j?5 1 -TO | .3*75 \
|

/50

[ 3000 —=

4, Sketch 3 on “DTM 2” should look like this...

— 200

5. Sketch 4 on “DTM 3” should look like this... A (.010”) profile at the origin.
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6. Select the Right datum plane ad draw a horizontal line at the origin and
dimension it 15” long.

7. Swept Blend: Exit any sketches and select Insert/Swept Blend.
[ PRTOO0G (Active) - Pro/ENGIMNEER Student Edition (for education

File Edit View Analysis  Info Applications Tools

O O e

* [atum planes w

Bo 1B |G

[ Shon~)[_se

[] PRTO00&.PRT

£F RIGHT
£ TOP
£F FRONT

i« PRT_CSYS_

£7 DTMl
£7 DTM2
£7 DTM3
¥4 Sketch 1
¥4 Sketch 2
¥ Sketch 3
¥4 Sketch 4

5

P

ek

iy

Hole...

Shell...

Rib...

Draft...
Round...

Auto Round...

Chamfer

Extrude...
Revolve...

Sweep

Blend

Swept Blend...

Helical Sween

= §
[ 3

3

Boundary | " Swept Blend

Variable 58 Swept Blend Tool

al
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n ves

T IR
§
%
1

A Sketch 5
% Insert Here
7 %Swept Blend 1

Section|2

) HT

9. Sections/Selected Sections: Select the 4 sketches in order from back to front.
Be sure to select the “Insert” button for every sketch to be entered.

Oa aE 4 n e
References  Sections  Tangency ~ Options  Properties
go E-_@ © Sketched Sections
() © St s

&

#

() PRT0006.PRT Section 1 3
L7 RIGHT 3 (Remove)
L7 TOP 3
omow B =
3 PRT_CSVS DI
L7 DTML

% Insert Here
P Swept Blend 1
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10. You should have % a boat hull now...

11. Use the Mirror feature and select the flat side face as the plane to mirror
from.

2

-
LN

12. Select the hull one more time and hit the green check mark to apply.
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13. You are finished with the boat Hull.

14. (Optional) Now dress it up for the contest...
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EXERCISE S
Top-Down Assembly Modeling

Top-Down Assembly Modeling is creating parts inside an assembly.

Objective: Create
an assembly of a

pencil sharpener.
If the width is

@ This configuration
" All canfigurations
" Specify configurations

1. Create a new assembly file.
2. Go to the Create icon.
3. Save it as E9_Front and drop it on the “Front” plane. Create the following

part from the drawing.

2.000
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SCALE2:]
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|

D IMENSIONS AREIN INCHES
TOLERA HCES:

FRACTIONAL 3
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TWO PLACED ECIMAL 1
THREEPLACE DECIMAAL =

P

M

DO HOTSCALE DRAWING

asur [

werea EXERCISE 10

carcun

s PENCIL SHARPENER

PL-PILIN

= FRONT BEZEL

COMLIAI,

ur (oG, wo. (I8

A

TAAL wHSAL surTr i ar

When finished select the Activate option to exit part editing mode.

4.

Insert another new component and save it as E9_Reservoir.

5.
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Create the following model in the context of the assembly-using offset or

6.

TrIND N

war o, oRCurioy o0&t Arrovin

050 TYP. WALL

vy
R.025 —
DETAIL B
SCALE3 :1
950 —=  1.000
K A
.m 500 DOME
m 1
o . _ \.\.\
S Ny L
_Lrl R 1 g
_ N, | #
9 yr_ 5\
w 4
(] 27| Se
<
5 7 Y
c e \ D
5 2 | N
&= : >
" \S = 2
2 A - SECTION A-A
)
£ e e S S EXERCISE 10
c FRACTIONAL 1
(] AHGLLAR: MACH 2 BEND 2
+— TWO PLACEDECIMAL 3
m MO PRIETARY ANC CONFICENTAL THREEELNEE PECINAL S H-L“s\-.«f wmzo__l MI\Pmezmm
S IME PO RMANDH COMIAINED I INE WATTRIAT D4, O C _U
n DRAVING B IMESCIEPROPERIY OF = I
o < INSERI COMPANY NAME MERE-. ANY ~
© _...eﬂ_ mmﬂd__u~u>u~_-0L.m““»ze”W_~ HERTAsSY | LsEb oW " = e oec. wo. .
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EXERCISE IO
Assembly Editing

This exercise will include both Bottom-Up and Top-Down Assembly Modeling.

Obijective: To
update the MP3
Assembly with the
changes requested
by the boss as noted
on the drawing.

7. Open the file called E10_asm assembly and modify according to the
instructions noted on the drawing provided. You will have to mate the
Battery part file.
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[TEM NO [PART NUMBERDESCRIPTION Q1Y
e : Shell this at 100"
3 Rear Bezel 1 and add a .05" x.1"
w m%o: Array ﬂ Righ lip with 1 degree
3 PCE 1 of draft.
7 IAA Battery 1
g8 |[Ear Phone Case 1
Mate AA-Battery
Moedel LED into socket

screen

Add these ribs
to hold the battery
in place;

Create this boss that
holds the ear phone case.

|maerscescim L T COLLEGE OF DUPAGE
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EXERCISE I
Sheet Metal Design

Objective: Model a
sheet metal
enclosure using
Top-Down
Assembly methods,
and flatten it.

1. Go to file/open and select E11 for file type and locate “Gear Enclosure”.

/7 Extrude

&

i

Flatten

Lo

S5
((
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2.

Insert a new part into the assembly; drop it on the end face of a gear shaft
of the assembly. Name it “Cover 2” (This will be the enclosure) then select
the front outside face. Convert Entities. “Offset”

Extrude up to vertex.
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4. Once completed the assembly should look like this. Right Mouse click on the
surface of the enclosure and select “open”.

I”

5. Convert to sheetmetal Go to an isometric view and “ctr!” select the four

faces as shown.

~

98






Rotate the view to select the fourth face.

100



6. To convert to a sheet metal part, select the pull down menu “Application/Sheet
metal” select the “shell” option.

6. Select the bottom face and select the “Conversion” icon.

| PRT0001, (Active) - Pro/ENGINEER Education Edition

File Edt View Insert Analysic Info Applications Took Window Help

YW : T r—
DL &QQ v § B pHie e
» Selected reference(s) wil be added.

@ Enter thickness inrange 0.0013t05.3733 062
* Cormversion of soid to sheet metsl changes the geometry and the corresportding ids

b |& G| aR

() PRTO00L.PRT

vErFaads el 8000 ahiakGw
]

© e |
O FIRST WAL
F Inser Here

ﬁ Conversion

_reake Conversion

[mat ¥4

reate Conversion

I ELt - ProfENSINEER & PR
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7.

8.

Go to the right view orientation and you should have this section view...

SMT CONVERSION [X]

\ |Element |Inf|:| |
"N Foint Frefiefs Optional
Edge Rip Optional
Fip Connect Optional
Bends Optiona
Cormer Reliefz Optional

[ Fefs ] [ Infio

Cancel Presiew

Click on the Rip parameters and select the two inside edges. Hit apply.

Menu Manager

w RIP PIECES
Rermove
Remaove Al
Redefine

Done Sets
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9. Double click on “Bends”. Hold the CTRL key while selecting. Hit done and
OK.

SMT CONVERSION (%]

|Element |Inf0
Fuoirt Reliefs Optional "
Edge Rip Defined : 2 rip pi
Rip Connect Optional
> Bends Drefining
Corner Reliefs Optional

[ Refs ][ Info

Cancel

[ Defing

Presiew

Menu Manager
w BEND PIEC

Remaove
Remave Al
Redefine

Done Sets

Select 1 item.

10. Select the flatten icon.
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12. Return to the assembly.

& Select an edge or chain of sdges to attach the wall,

% =8

| Det.asm

[J PULLEY.PRT
(1 BRACKET.PRT
[}l BELT.PRT

[0 GEAR_LPRT
[ ) GEAR_2.PRT
[0 PRTO0O3 PRT

|
File Edit Wiew Insert Analysis Iofo Applications Tools Manikin ‘Window Help
DEES800 vo iR fn ~ MrEnaalds el 8000 2hAa%G W
=
& Select an edge or chain of sdges to attach the wall,
® Pause mode has been cancelled.
=)

L

E & &

I

13. Add holes and additional features.

14. The enclosure is now completed.
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BONUS INFORMATION
ProE Creo Administration

Finding adequate computer hardware to run Inventor can be challenging, this lesson
looks at the multiple aspects of selecting hardware as well as modifying settings inside
Creo to allow it to run efficiently and trouble free.

Selecting an Operating System (OS).
Windows 7

Windows 8

Windows 10

Virtual Memory Settings inside the OS. It may be a good idea to increase or adjust your
virtual memory setting. The norm would be x2 —x3 your current amount of ram.

Example 512MB of Ram 1000 — 1500 MB Virtual Ram. And keep the initial size the same
as the maximum size. It is said that this prevents write errors.

ol Pane L]
2 5
! File Edit Wew Favorites Tools  Help a.
Q- © ¥ p Seerch [ Folders | (3]~
: Address |G’ Control Panel v| G
Mew Office Document Accessibility  Add Hardware add or Administrative  Automatic  Date and Time Cisplay
Category View Oiptions Remov... Tools Updates
@ Open Office Document — A .
( \ &
@' Set Program Access and Defaulks l ——
Folder ptions Fonts Game Inkernet Java Keyboard Mail
@ Windows Catalag ndate Cantrollers Options
upport &y % q L
E. é]/ g fﬂ;;
[ .
% ‘Windows Update \_) @J
fas ) Mouse Metwork  Metwork Setup MWIDIA nWiew  Phone and  Portable Media Power Options
" TopSolid 2005 Connections Wizard Desktop M., Maodem ... Devices
& » 2 @ e & 7 © 9
L '
(@ prooams 2 4 = 2
LY . N Printers and CuickTime  Regional and  Scanners and  Scheduled Security Sounds and
/ < Faxes Language ... Cameras Tasks Center Audio Devices
5 W - —— E
: N . g e @
> e_, nections —
; ¢ “ 4 A Printers and Faxes h System Taskbar and  User Accounts  Wiewpoint tiindows ‘fireless Link
= - Start Menu Firewal
= 0_) Help and Suppaort (o Taskbar and Start Menu I\
4 =7 Rrun.. =Y
Wireless
Mebwork Set...
- h'“l Log OFF Chris...
E Turn OFf Computer. ..
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System Properties

|E| \X| " Performance Options |E| |z|

| System Restore

Automatic: Updates /ﬂ

Remate N |

Visual Effects | Advanced ‘ Data Execution Preventiunl

231 Final

Virtual Memory

| Geneal | ComputerMame | Hardwan

Performance

Wisual effects, processor scheduling, mem 30¢, and v

Uzer Profiles

Desktop gettings related to your logon

Startup and Recavery

System startup, system failure, and debugging information

| Advanced
Y'ou must be logged on as an Administrator to make most of T

[ Enviranment Yariables ] [

Error Reporting ]

Processar scheduling

By default, the computer is set to use a greater share of
processor time to run your progeams,

Adjust for best performance of:

(%) Programs () Background services
Memory usage

By default, the computer is set ta use & greater share of
memory to run your programs.,

Adjust For best performance of:
() Programs () system cache
Yirkual memory

A paging file is an area on the hard disk that Windows uses as
if it were RAM,

Total paging file size fz

ME

Drive [volume Label]

Paging File Size (MB)

Paging file size for selected drive
Drive:

Space available:
() Custom size:
Initial size (ME):

H:
3435 ME

Maximum size (ME):
O System managed size
(N paging file

Total paging file size for all drives

Minimum allowed: 2 ME
Recommended: 765 MB
Currently allocated: 768 MB

Apply

Mouse Metwork et
Connections

Processors (CPU)

Intel

Atom
Celeron
Pentium
Corei3
Core i5
Core i7
Xeon

AMD
Sempron
Athlon Il
Phenom X2,3,4,6
VISION A4,6,8,10
FX Series
Opteron

=

e 1=t o e e

SLOWER

FASTIER
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http://www.tomshardware.com/2005/11/21/the_mother_of_all_cpu_charts_2005/
http://www.xbitlabs.com/articles/cpu/display/sempron-2600.html

Multiprocessing

Most CPU manufacturers are beginning to deliver multiple core processors. This can be

seen with the AMD FX which has up to eight processing cores.

Which one will run Creo fastest? You can find benchmarks at www.spec.org specifically
for Creo or you can look for the generic OpenGL benchmark results that usually use an

OpenGL video game.

The question is: “Can Creo benefit from multiple cores?” Currently one might find an
average of 10 — 15% performance increase with general modeling. This is because Creo
is not fully written to take advantage of multithreaded processes. However, using the
Creo Simulation, CFD, or Photolux rendering solutions one may discover 2x — 12x faster
performance versus a single core processor. This is because these Creo applications do
take full advantage of multithreaded processing.

The biggest benefit one might find is the ability to multitask while working with an FEA
analysis. This is a long process and you could actually open up another window of Creo
or Outlook and continue working while the analysis is running with little slow down in

performance.

To check out what your computer has inside without opening the case download the
free version of CPUID — CUP-Z http://www.cpuid.com/softwares/cpu-z.html

Or ctrl-alt-del and start task manager to see how many threads your CPU has, as well as
how much RAM.

CPU-Z - —— (e | )
H S e
{cru I Caches 1 Mainboard I Memury] SPD I Graphics I About I File Options View Help
Processor [ pplications | Processes | services | Performance | Networking | users | |
Name Intel Core i7 3930K __/m CPU Usage CPU Usage History
Code Name | Sandy Bridge-E  Max TDP | 130 W |nte inside”
Package Socket 2011 LGA Sl i
(| Technoboy | 320m  Core'ohage | 0852V CORE'i7 I
I Specification Intel(R) Core(TM) i7-3830K CPU @ 3.20GHz [
Family 6 Model D Stepping 7 i Memory Physical Memory Usage History
N Ext. Family [ Ext Model | 2D Revisian c2 ||
| Instructions | MMX, SSE {1, 2, 3, 35, 4.1, 4.2), EMB4T, VT-x, AES, AVX i
| Clocks (Core #0) Cache
Core Speed 1200.13 MHz L1Data | 6x 32 KBytes 8-way Physical Memary (M) System
Multiplier x 120 L1 Inst. 6 x 32 KBytes B-way Total 16333 Handles 22225
Cached 5166 Thread: 892
|| BusSpesa [ 1000 HHz Level2 | 6x256 KBytes | &-way | veiebie 12641 | | Processes
QPI Link 3200.4 MHz Level 3 12 MBytes 16-way Free 7560 | UpTime 0:05:21:51
I Commit (GB) 3/31
Kernel Memory (MB)
Paged 398
Selection |Processor #1 Cores | 6 Threads | 12 Nonpaged 162
Version 1.61.3.364 validate ‘ oK I Processes: 63 CPU Usage: 0% Physical Memory: 22%
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Graphics Cards

Here are a few brands that are in the Professional Category and actually have specific
drivers that are written to run Inventor at its best.

NVIDIA Quadro series (not NVS series)

° Quadro FX K600 erp$159 (erp- estimated retail price)

;
e Quadro FX K2000 erp.$499 ;‘ - |
e Quadro FX K4000 erp.$799 j , |

)
—_— |
e ATI FirePro series (not FireMV series)

e FirePro 3900 erp.$159 |
e FirePro 5900 erp. $499

e FirePro 7900 \

e Intel Xeon “

P4000 HD integrated graphics (must be P = Professional rated)

These cards are considerably more expensive that mainstream cards but the benefits of
experiencing less crashes or visual problems with Pro/E outweigh the cost.
If you are using Inventor at work, DON’T SKIMP! Buy a professional grade video card. For

home use the nVidia Geforce or AMD Radeon series are fair, but you will still experience
some graphical glitches.

GRAPHICS CARD — Creo BENCHMARK (source: www.tomshardware.com)

MEMORY (RAM)

4.0 - 16.0 GB From simple machined parts to complex assemblies. The more RAM the
better.

3.0 GB+ Requires Windows XP/Vista/7 64 Bit Editions ‘1
\ o —— \

|
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Bonus EXERCISE 3B
Family Tables

Family Tables enable you to create multiple part configurations derived from a single
part file.

GOAL: Learn how to make
multiple part configurations
within a single part file.

In this exercise we make a
cast and machined version
of the ratchet.

1. Open the Exercise_4 FAMILY part file.

Ml PRTODD9_INST1 {Active) - Pro/ENGINEER Education Edition -0l x|
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2. Go to the pull down menu- “Tools/Family Tables”
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Select ﬂjﬂ to add dimensional or feature parameter columns toghe table.

Select EII! to define instance model rows as design variationg/of the current mode!

substituting different values in the cells for thoze parametegl in each instance.

Ok, LCancel

3. Select the “Insert new insatnce” two times. Then hit the “Add...” icon.
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4. Select the Feature option, then select the “Extrude 4, 5, and 6”
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5. Select “OK”.
6. Select “Verify”

7. In the columns type “N” for no- to supress the feature, or “Y” for yes for the

feature to be unsupressed. Hit “OK”.
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8. Hit “Verify” once again on the smaller Family Tree box.
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10. To open the additional instances go to File/Open, and select the original file,
when it opens it will prompt you with a list of Family Parts available. FIN
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